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ABSTRACT

This document provides guidance on how to download and install the LDC5072 Sensor design tool Additionally, 
the document gives a brief overview of the tool's capabilities and features, steps for the design tool, and shows 
how to use the tool to create and use a SPICE model of the design. Also included is instructions for creating a 
set of Gerber files for a sensor design and a layout and schematic of the resulting test board.

Table of Contents
1 Introduction.............................................................................................................................................................................3
2 Gaining Access to the LDC5072 Sensor Design Tool......................................................................................................... 4
3 Installer Setup......................................................................................................................................................................... 5
4 Installing the Tool................................................................................................................................................................... 8
5 Tool Overview........................................................................................................................................................................13
6 Using the Tool to Create a Design and Generate a Supporting SPICE Model and Gerber Files...................................21
7 Running Simulations in Pspice........................................................................................................................................... 28
8 Layout, Bill-of-Materials, and Schematic of the Test PC board........................................................................................46
9 Troubleshooting....................................................................................................................................................................52
10 Revision History................................................................................................................................................................. 53

List of Figures
Figure 3-1. LDC5072 Design Tool Installer Shortcut on Desktop................................................................................................ 5
Figure 3-2. LDC5072 Sensor Design Tool Installer & Setup Start Panel.....................................................................................5
Figure 3-3. LDC5072 Sensor Design Tool License Agreement................................................................................................... 6
Figure 3-4. Directory Path for Tool Installer & Setup................................................................................................................... 6
Figure 3-5. Ready to Download Installer Status Window............................................................................................................ 7
Figure 3-6. Installer Download & Setup Complete Status Window..............................................................................................7
Figure 4-1. Tool Installer Initial Splash Screen............................................................................................................................ 8
Figure 4-2. Tool Installer Start Panel .......................................................................................................................................... 9
Figure 4-3. Select/Configure Directory Path for Tool Installation................................................................................................. 9
Figure 4-4. Required Software Panel - MATLAB Runtime Engine.............................................................................................10
Figure 4-5. Confirm Software and Directories for Tool Installation............................................................................................ 10
Figure 4-6. Successful Tool Installation - Confirmation..............................................................................................................11
Figure 4-7. Revising the Tool's Desktop Shortcut - Setting the Start in: Path............................................................................12
Figure 5-1. Starting the LDC5072 Sensor Designer - Splash Screen....................................................................................... 13
Figure 5-2. LD5072 Sensor Designer Start Screen................................................................................................................... 14
Figure 5-3. GUI Input Field Summary .......................................................................................................................................14
Figure 5-4. GUI Front Panel Help Pop-up................................................................................................................................. 15
Figure 5-5. LDC5072 Sensor Designer Mechanical Design Tab............................................................................................... 16
Figure 5-6. LDC5072 Sensor Designer Mechanical Design Help Pop-up................................................................................. 16
Figure 5-7. LDC5072 Sensor Designer PCB Design Tab.......................................................................................................... 17
Figure 5-8. LDC5072 Sensor Designer PCB Design Help Pop-Up........................................................................................... 18
Figure 5-9. LDC5072 Sensor Designer Manufacturing Tolerance Tab...................................................................................... 18
Figure 5-10. LDC5072 Sensor Designer Manufacturing Tolerance Help Pop-Up..................................................................... 19
Figure 5-11. LDC5072 Sensor Designer Sensor Targets Tab....................................................................................................19
Figure 5-12. Sensor Targets Tab Help Pop-Up..........................................................................................................................20
Figure 6-1. LDC5072 Sensor Designer Tool Start Panel........................................................................................................... 21
Figure 6-2. LDC5072 Sensor Designer Tolerances Tab............................................................................................................ 22
Figure 6-3. LDC5072 Sensor Designer Sensor Parameters Tab...............................................................................................22
Figure 6-4. Schematic Representation of the Sensor Spice Model........................................................................................... 23

www.ti.com Table of Contents

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 1

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Figure 6-5. Parameter Help Pop-up for the Sensor Spice Model.............................................................................................. 24
Figure 6-6. LDC5072 Sensor Designer Front Panel: Completion of a Valid Design..................................................................25
Figure 6-7. LDC5072 Sensor designer Custom Sensor Tab..................................................................................................... 25
Figure 6-8. Spice Model Creation for the Sensor, LDC5072 and a Test Bench.........................................................................26
Figure 6-9. Gerber File Creation for the Sensor, LDC5072 and a Test Bench.......................................................................... 27
Figure 7-1. Starting the Cadence Allegro Pspice Simulator in the Windows Start Menu.......................................................... 28
Figure 7-2. Cadence Allegro Pspice Simulator Window............................................................................................................ 29
Figure 7-3. Opening the Spice Test Bench - Step 1.................................................................................................................. 30
Figure 7-4. Opening the Spice Test Bench - Step 2.................................................................................................................. 31
Figure 7-5. Sensor + LDC5072 Test Bench Open in Allegro Pspice Simulator......................................................................... 32
Figure 7-6. Test Bench Pspice Simulation Statements..............................................................................................................33
Figure 7-7. Starting the Pspice Test Bench Transient Simulation from the Simulation Menu....................................................34
Figure 7-8. Starting the Pspice Test Bench Transient Simulation from the Run Button.............................................................35
Figure 7-9. Status of a Running Pspice Simulation................................................................................................................... 36
Figure 7-10. Initial Allegro Pspice Plot Window After Completion of Simulation....................................................................... 37
Figure 7-11. Adding a Trace to the Allegro Pspice Plot Window............................................................................................... 38
Figure 7-12. Adding the Trace for LDC5072 Channel 0 (COS) Differential Output Voltage...................................................... 38
Figure 7-13. Plotted Curve for LDC5072 Channel 0 (COS) Differential Output Voltage............................................................39
Figure 7-14. Adding the Trace for LDC5072 Channel 1 (SIN) Differential Output Voltage........................................................ 39
Figure 7-15. Plotted Curve for LDC5072 Channel 0 (COS) and Channel 1 (SIN) Differential Output Voltages........................ 40
Figure 7-16. Adding a Plot Window........................................................................................................................................... 41
Figure 7-17. New Empty Plotting Window................................................................................................................................. 42
Figure 7-18. Add the Trace for the Target/Mechanical Angle.................................................................................................... 43
Figure 7-19. Addition of the Plotted Target/Mechanical Angle...................................................................................................44
Figure 7-20. Add Waveforms of Computed and Ideal Electrical Angle......................................................................................44
Figure 8-1. Top Side of Sensor, LDC5072 and Target PC boards created by the LDC5072 Sensor Design Tool.....................47
Figure 8-2. Underside of Sensor, LDC5072 and Target PC boards created by the LDC5072 Sensor Design Tool.................. 48
Figure 8-3. Evaluation PC Board Schematic Without Sensor....................................................................................................49
Figure 8-4. Detailed EVM Relative Part Placement for Soldered Components - Identical to Tool-Generated EVM..................51
Figure 9-1. LDC5072 Sensor Designer State File..................................................................................................................... 52

List of Tables
Table 8-1. LDC5072Q1EVM BOM............................................................................................................................................. 50
Table 9-1. Approxmate Sensor Tool Elapsed Times for a Given Set of Design Parameters..................................................... 52

Trademarks
All trademarks are the property of their respective owners.

Trademarks www.ti.com

2 LDC5072-Q1 Sensor Design Tool Getting Started Guide SNOU195 – JULY 2023
Submit Document Feedback

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


1 Introduction
The LDC5072-Q1 is an inductive sensor interface that has been designed to provide accurate estimates of a 
motor's position using simple, inexpensive conductive targets and sense coils. These are usually implemented 
on PC boards with two or more layers. The LDC5072-Q1 contains internal fault-management circuitry that can 
alert a system monitor to opens or shorts in PC board traces or wire harnesses, or out-of-range signal levels. For 
more information, please see the LDC5072-Q1 device data sheet or functional safety manual.

While the system comprised of the target, sensors, and the LDC5072 is simple, designing the sensors to give 
the desired system behavior can be potentially challenging. Quantifying the electromagnetic interplay of the 
target, exciter coil, sense coils and the relationship to motor speed, position, and the resulting accuracy of the 
angle estimates can be difficult and complex. This is where this design tool can help.

The remainder of the document is divided into nine sections. The next section describes how to gain access 
to the tool and download the installer. The section Installing the Tool discusses the steps of installing the tool 
(based on the MATLAB run-time engine) with particular attention to the folder paths and operating system 
permissions. The section Using the Tool to Create a Design discusses the design steps with an example set 
of design criteria. The tool also creates a SPICE model of a design. Using the Tool to Create a SPICE Model 
of Your Design with the LDC5072 provides background on creation of a SPICE model and gives an overview 
of the model files. Running Simulations in Pspice shows how use the SPICE model in the Cadence Pspice for 
TI simulation manager. The tool creates Gerber files of a design with a single button-click, and Create Gerber 
Design Files reviews the results of the sensor files, target and eval PC board. The next-to-last section provides 
the bill-of-materials, layout and schematic of the eval PC board. The final section is a brief troubleshooting guide.

www.ti.com Introduction

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 3

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


2 Gaining Access to the LDC5072 Sensor Design Tool
There are two series of steps to access and install the tool. The first series is the installer setup: download 
the installer using your active myTI acount, choosing the installation directory, approving the license agreement, 
and unpacking the installer files. The second series involves running the installer: choosing the directories, 
downloading and installing the MATLAB run-time envorinment (if not already installed), and completing and 
confirming the installation.

To gain access to the LDC5072 Sensor Design Tool you must have an active myTI account. Once you have 
created a myTI account go to the LDC5072-Q1 product folder and scroll down to the Design Tools & Simlation 
tab. Click on the link LDC5072 Sensor Design Tool or click the corresponding download button and view the 
export approval page. Once there, complete the form and transition to another page that confirms that you have 
been granted approval. Click the Download button to download the tool installer.
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3 Installer Setup
After the download, a shortcut appears on your deskop.

Figure 3-1. LDC5072 Design Tool Installer Shortcut on Desktop

Double-click the icon and ignore any messages from Windows Defender. The Setup pop-up appears.

Figure 3-2. LDC5072 Sensor Design Tool Installer & Setup Start Panel

Click the Next button and the License Agreement appears.
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Figure 3-3. LDC5072 Sensor Design Tool License Agreement

Read the license agreement. If the terms are acceptable, click the I accept the agreement radio button and the 
Next button. The next pop-up shows a default installation path, but allows an alternative path to be entered.

Figure 3-4. Directory Path for Tool Installer & Setup

Once the installation path is entered, click the Next button and a status window shows the setup is ready to 
install. Click Next to begin the setup and file unpacking.
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Figure 3-5. Ready to Download Installer Status Window

When the setup and unpacking are complete, a final pop-up appears.

Figure 3-6. Installer Download & Setup Complete Status Window

Click Finish and the installer setup is complete.

Note
A ReadMe file displays that contains the location of the unpacked files. This information is needed for 
the next series of installation steps.
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4 Installing the Tool
After the installer setup is complete, begin the tool installation by going to the directory listed in the 
ReadMe file shown at the end of the previous Installer Setup series and double-clicking on the file 
MyAppInstaller_web_V#.exe.

Click on the desktop icon and the splash screen briefly appears.

Figure 4-1. Tool Installer Initial Splash Screen

After the splash screen disappears, the first of the installer pop-ups appears. Click the Next button.

Installing the Tool www.ti.com

8 LDC5072-Q1 Sensor Design Tool Getting Started Guide SNOU195 – JULY 2023
Submit Document Feedback

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Figure 4-2. Tool Installer Start Panel 

The Installation Options pop-up appears with a default installation path. Enter an alternate path if needed. Leave 
the check-box checked if you want a shortcut added to your desktop and click Next.

Figure 4-3. Select/Configure Directory Path for Tool Installation

The Required Software pop-up appears. Click Next to install the MATLAB Runtime Engine (if not already 
installed.)

www.ti.com Installing the Tool

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 9

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Figure 4-4. Required Software Panel - MATLAB Runtime Engine

The next two pop-ups confirms the installation directories, and the successful completion of the installation.

Figure 4-5. Confirm Software and Directories for Tool Installation
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Figure 4-6. Successful Tool Installation - Confirmation

Note
The final step is to update the new desktop short-cut that was part of the installation.

Open the Properties of the desktop short-cut by right-clicking and 
selecting the last menu item. Change the Start in: directory to: 
C:\Users\USER_ID\AppData\Roaming\Texas_Instruments\LDC5072_Sensor_Designer\application 
otherwise the supporting .PNG files cannot be found and Windows security cannot allow the log file to 
be written.
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Figure 4-7. Revising the Tool's Desktop Shortcut - Setting the Start in: Path
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5 Tool Overview
This section gives a user-oriented overview of the tool including the inputs and features.

To start the tool, click on the LDC5072_Sensor_Designer short-cut on the desktop (if that option was chosen) or 
from the Windows Start menu. The splash screen shown below appears for a few moments and then closes.

Figure 5-1. Starting the LDC5072 Sensor Designer - Splash Screen

A 60-second lapse between the splash screen closing and the appearance of the sensor design tool GUI (shown 
in Figure 5-2) is normal.
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Figure 5-2. LD5072 Sensor Designer Start Screen

The main GUI front panel entries are summarized in Figure 5-3.

Figure 5-3. GUI Input Field Summary 
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The tool can support a variety of sensor shapes, as specified in the Sensor Type field near the top of the GUI. 
Inputs for operational and environmental factors (motor rotational speed and acceleration, ambient temperature) 
are on the upper right side of the GUI. The lower right side of the GUI contains buttons for creating a SPICE 
model and PC board Gerber files of the design. The Angle Error guage gives an estimate of the overall angle 
accuracy of the design. The Save Design button saves the current design and the Load Design button allows 
the tool to import a saved design. Together these buttons allow a user to manage multiple designs and/or 
incrementally optimize a single design. The Log window, near the bottom of the GUI, displays the contents of 
the log file. Clicking the Design Sensor button in the lower left of the GUI starts a sensor design, which in turn 
causes the Valid Design indicator to turn red. The indicator turns green when the design is complete.

There is a Help button on each page. The Sensor Design Help button provides information about the buttons 
and entry fields of the GUI front panel as shown in Figure 5-4.

Figure 5-4. GUI Front Panel Help Pop-up

The Mechanical Design tab shown just below is one of seven tabs, each with individual input fields. Note that 
most tabs have a Mechanical Design Help button.
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Figure 5-5. LDC5072 Sensor Designer Mechanical Design Tab

The Mechanical Design Help pop-up can be seen by clicking that tab's Mechanical Design Help button and is 
shown in Figure 5-6.

Figure 5-6. LDC5072 Sensor Designer Mechanical Design Help Pop-up
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As the design help graphic shows above, this tab's input fields specify the mechanical dimensions of the sensor, 
target, and motor shaft. The field Ratio Electrical to Mechanical specifies the number of petals on the target; 
each petal represents a partial mechanical rotation and a complete electrical rotation through 360 degrees. As 
an example, a four-petal target rotating through 360 degress represents a single mechanical rotation and four 
electrical rotations.

The PCB Design tab shown just below contains input fields for the widths and thicknesses of the PC board 
traces, vias and layers, with the meaning of these parameters shown in the PCB Design Help image in the 
second figure.

Figure 5-7. LDC5072 Sensor Designer PCB Design Tab

www.ti.com Tool Overview

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 17

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Figure 5-8. LDC5072 Sensor Designer PCB Design Help Pop-Up

Design trade-offs between the electrical and mechanical fabrication constraints impact the cost and reliability of 
the PC board. The PC board parameters can also negatively affect performance if traces are made too thin, 
thereby increasing parsitic resistance.

The Manufacturing Tolerance tab's input fields specify the relative spacing and tilt between the sensor and 
target, as well as the relative angle of the target with respect to the sense coils. Variation Rate, Runout and Coil 
and Target Tilt are some of the parameters that can be specified in this tab.

Figure 5-9. LDC5072 Sensor Designer Manufacturing Tolerance Tab
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Figure 5-10. LDC5072 Sensor Designer Manufacturing Tolerance Help Pop-Up

The Sensor Targets tab allows advanced users to design sensors that are outside the guidelines of the data 
sheet. Not all parameters in this tab can be changed for all sensor types. Clicking the Optimizer Help button 
gives a high-level explanation for the optimizer parameters, as shown in the second figure just below.

Figure 5-11. LDC5072 Sensor Designer Sensor Targets Tab
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Figure 5-12. Sensor Targets Tab Help Pop-Up

The LDC5072 Tolerances tab is used to modify the typical performance of the LDC5072 as described in the 
Electrical Characteristics section of the device data sheet. Changes to this tab modify the LDC5072 Spice model 
to reflect the values entered in this tab. The Spice model is covered in more detail in Using the Tool to Create a 
Design and Generate a Supporting SPICE Model and Gerber Files.
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6 Using the Tool to Create a Design and Generate a Supporting SPICE Model and 
Gerber Files
Upon starting the tool, the Log window is empty and the Valid Design indicator is red as shown in Figure 6-1.

Figure 6-1. LDC5072 Sensor Designer Tool Start Panel

The example illustrated here assumes the parameters across all of the tabs stay at the default values. Note 
the parameters Max Velocity and Max Acceleration on the right side of the front panel, and which impacts 
Spice simulations. In simulations, the Max Acceleration controls the speed-up from zero to Max Velocity. If 
the acceleration is set to zero, then the target starts and operates at Max Velocity, which is recommended for 
short run times. If Max Acceleration is non-zero, the target starts at zero rotational speed and accelerates to 
Max Velocity, then deccelerates back to zero velocity. This can result in very long run times. The Temperature 
parameter sets the ambient temperature of the Spice simulation.

The Spice model can be made to include tolerances from the LDC5072 data sheet via the LDC5072 Tolerances 
tabs. The table in the Sensor Parameters tab provides summary tables of the mutual inductances and 
resistance, as well as the sensor coefficients of capacitance and inductance as calculated by the optimizer.
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Figure 6-2. LDC5072 Sensor Designer Tolerances Tab

Figure 6-3. LDC5072 Sensor Designer Sensor Parameters Tab

A schematic representation of the sensor Spice model can be seen by clicking the Sensor Model Diagram button 
on the Sensor Parameters tab. An explanation of the sensor electrical parameters can be seen by clicking the 
Parameter Help button.
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Figure 6-4. Schematic Representation of the Sensor Spice Model
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Figure 6-5. Parameter Help Pop-up for the Sensor Spice Model

Clicking the Design Sensor button starts the tool optimizer, with Log window entries scrolling through different 
status messages as the design progresses. When the design is complete, the Valid Design indicator turns green 
and the Log window displays "....completed design process." as shown in the figure below.
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Figure 6-6. LDC5072 Sensor Designer Front Panel: Completion of a Valid Design

Some of the physical characteristics of the sensor designed by the tool's optimizer can be varied. After the 
optimizer produces a design, click the Import button on the Custom Sensor tab shown in the figure below to 
import the physical characteristics. Adjustments to the optimizer-created design can now be made. When the 
box Use this custom design for Save Design, Create Gerber Files, and Create TINA Model functions is checked, 
then the tool generates Gerber files and Spice models based on the adjusted design.

Figure 6-7. LDC5072 Sensor designer Custom Sensor Tab

www.ti.com Using the Tool to Create a Design and Generate a Supporting SPICE Model and Gerber Files

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 25

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


The tool can create three SPICE model files by clicking the Create Spice Model button after completion of a 
design. The tool can also create Gerber files by clicking the Create Gerber Files button after the completion of 
the design.

The SPICE models are in the form of text files with .cir extensions. One file is for the sensor and target model 
(as shown in the Figure 6-4 above). One file is for the LDC5072 model, and one is a test bench that can run 
a transient simulation of the sensor+target+LDC5072. Details on how to best run the test bench simulation are 
provided in the section Running Simulations in Pspice

Figure 6-8. Spice Model Creation for the Sensor, LDC5072 and a Test Bench

Note
When creating the SPICE models, please choose the default folder instead of navigating to an 
alternate folder. If an alternate directory is chosen, not all of the three models can be saved.

Clicking the Create Gerber Files button on the front panel makes the tool create a set of Gerber 
files for the target, sense coils and an evaluation PC board with the sense coils and an LDC5072-Q1 
device. This also creates *.pdf files of those assemblies, as well as schematics, and part placement 
diagrams and displays these as a pop-up. All files are saved to the application folder when created (e.g. 
C:\Users\UserID\AppData\Roaming\Texas_Instruments\LDC5072_Sensor_Designer\application\SensorGerber#)
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Figure 6-9. Gerber File Creation for the Sensor, LDC5072 and a Test Bench
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7 Running Simulations in Pspice
This section shows how the Spice models created by the tool can be used in a Spice transient simulation. These 
instructions assume the Spice models for the design have been created as described in the previous section.

All three models are usable in many Spice simulators, including Pspice for TI. The sensor and LDC5072 device 
models (SensorModel.cir, LDC5072.cir) can be imported and used as components in a larger schematic capture 
and/or circuit simulation, while the test bench file LDC5072_TB.cir can support a stand-alone Spice simulation. 
The remainder of this section gives an overview of how to use the test bench in a transient simulation using the 
Cadence Allegro Pspice Simulator.

The Cadence Allegro Pspice Simulator is started by selecting the PSpice AD application in the Windows Start 
menu as shown in the figure below. The number 17.4 refers to the version number of the tool used in this 
example.

Figure 7-1. Starting the Cadence Allegro Pspice Simulator in the Windows Start Menu

The simulator window appears and resembles Figure 7-2.
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Figure 7-2. Cadence Allegro Pspice Simulator Window

As shown in Figure 7-3 and Figure 7-4, after the window appears the test bench is opened by selecting the File 
> Open command in the upper menu, and navigating to the application folder. The File Type field in the window 
needs to be changed to *.cir to be able to see the test bench file LDC5072_TB.cir. Select the file and click Open.

Note
For the test bench simulation to run, the LDC5072 model (LDC5072.cir) and the sensor model 
(SensorModel.cir) must be in the same folder as the test bench file.
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Figure 7-3. Opening the Spice Test Bench - Step 1
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Figure 7-4. Opening the Spice Test Bench - Step 2

If you are using Pspice for TI you do not have the option of starting the Cadence Allegro Pspice Simulator 
directly from the Windows Start menu. You can easily access the simulator window by opening Pspice for TI and 
running a simulation of one of the built-in internal test benches. The Cadence Allegro Pspice Simulator window 
appears during or upon completion of the test bench simulation. After the completion of the simulation, close any 
plot windows and open your sensor design's test bench via the File > Open command in the upper menu and 
following the steps in the previous paragraph.

Opening the LDC5072_TB.cir file in Allegro can appear similar to the image shown just below. The upper 
parameters and comments reflect values for the sensor design. The first two .PARAM statements reflect the 
motor's rotational Max Velocity and Max Acceleration values chosen for this sensor design. For this example, 
the value in the comment "Target Electrical Rotation Rate in RPM = 1920000.0" results from the product of the 
parameters on the Mechanical Design tab Max Velocity (= 480 kRPM) and the Ratio Electrical to Mechanical 
(= 4). The .PARAM CLOAD = 10.000 n reflects the nominal load capacitance of the LDC5072 analog outputs. 
The parameters OSCSTARTUP, PERIOD, ACCPERIOD remain at their assigned values and do not change. The 
TEMP parameter was chosen in the Mechanical Design tab and reflects the modeled ambient temperature. The 
two .LIB statements include the sensor and LDC5072 device models in the test bench. Without those starements 
the test bench circuit is not complete.
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Figure 7-5. Sensor + LDC5072 Test Bench Open in Allegro Pspice Simulator

At the botton of the test bench file (see Figure 7-6) are the simulation analysis statements (.TRAN and .FOUR) 
and the uncommented .OPTIONS statements that set the convergence behavior (trade-off betwen simulation 
speed and accuracy) of the simulator. The .PROBE statements specify data-gathering for post-simulation 
plotting. Note that the last .PROBE statement has voltages that represent the mechanical angle, the computed 
electrical angle, and the ideal electrical angle (e.g. V(MECHANICAL), V(COMPUTED) and V(IDEAL)). The next-
to-last .PROBE statement has differential voltages that represents the differential outputs of the LDC5072 output 
pins - V([XLDC5072.OUT01P],[XLDC5072.OUT01N]) and V([XLDC5072.OUT11P],[XLDC5072.OUT11N]).

Note
For additional details on the meanings of the SPICE statements and declarations, please consult 
some of the many references about Spice simulation. Please note the last six comments of the 
file that describe the waveform-dependent requirements for credible results and also advise against 
modifying the simulation time.
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Figure 7-6. Test Bench Pspice Simulation Statements

The simulation is started by selecting Simulation > Run LDC5072_TB in the upper menu, or by clicking the 
right-pointing arrow in the upper banner as shown in the figures below. The simulation time depends on the 
design, the analysis parameters (.TRAN), and the .OPTIONS parameter values. If you are unfamiliar with Spice 
simulations, please be aware that some combinations of parameter values can result in long simulation times.
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Figure 7-7. Starting the Pspice Test Bench Transient Simulation from the Simulation Menu
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Figure 7-8. Starting the Pspice Test Bench Transient Simulation from the Run Button

While the simulation is running, you can see status messages in the Output Window, and the completion status 
as a percentage in the lower right-hand status bar.
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Figure 7-9. Status of a Running Pspice Simulation

For this example, the simulation is stopped after approximately 880 us, and the plot window appears as an 
additional tab in the simulator panel as shown in Figure 7-10. The next few steps illustrate how to plot the 
LD5072 output pins' voltages, as well as angle estimates that model the target angular rotation. You can plot the 
results by selecting either Trace/Add Trace, or by clicking the Add Trace button in the icon ribbon as shown in 
Figure 7-11.
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Figure 7-10. Initial Allegro Pspice Plot Window After Completion of Simulation
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Figure 7-11. Adding a Trace to the Allegro Pspice Plot Window

The first step is to select the differential voltage of the LDC5072 channel 0 (COS) output pins and by first clicking 
Add Trace and selecting V(XLDC5072.OUT01P,XLDC5072.OUT01N) as shown in Figure 7-12.

Figure 7-12. Adding the Trace for LDC5072 Channel 0 (COS) Differential Output Voltage

This shows a plot similar to Figure 7-13.
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Figure 7-13. Plotted Curve for LDC5072 Channel 0 (COS) Differential Output Voltage

The second step is to add and select the differential voltage of the LDC5072 channel 1 (SIN) output pins by 
clicking Add Trace and selecting V(XLDC5072.OUT11P,XLDC5072.OUT11N).

Figure 7-14. Adding the Trace for LDC5072 Channel 1 (SIN) Differential Output Voltage

This shows a plot similar to Figure 7-15.
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Figure 7-15. Plotted Curve for LDC5072 Channel 0 (COS) and Channel 1 (SIN) Differential Output 
Voltages

The next steps add an additional plot to the window to separate the LDC5072 pin voltage curves that were just 
plotted from the curves that show estimates of the target rotational angle. The first step is to add an additional 
plot window by selecting Plot/Add Plot to Window from the menu.

Running Simulations in Pspice www.ti.com

40 LDC5072-Q1 Sensor Design Tool Getting Started Guide SNOU195 – JULY 2023
Submit Document Feedback

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Figure 7-16. Adding a Plot Window

This places a new, empty plotting grid in the upper half of the plotting window.
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Figure 7-17. New Empty Plotting Window

Next add and plot the waveform that represents the physical angle of the target, which is represented by the the 
curve V(MECH_ANGLE) as shown in Figure 7-18 and Figure 7-19.
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Figure 7-18. Add the Trace for the Target/Mechanical Angle

The plotted mechanical angle has an inital value of zero at the start of the simulation, but then moves between 
-180 degrees to 180 degrees as the target moves through full mechanical rotations. This is shown in Figure 7-19 
where the units are displayed in volts, and represent the target position in degrees where one volt represents 
one degree of target rotation.
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Figure 7-19. Addition of the Plotted Target/Mechanical Angle

Using similar steps, additional traces can be added which represent the computed electrical angle 
(V(COMPUTED)) and the angle (V(IDEAL)). The angle (V(COMPUTED)) is equal to the arctangent of the COS 
and SIN output channels and includes the effects of the time delays. The ideal electrical angle (V(IDEAL)) is also 
computed as an arctangent, but is based on the actual angle of the target and does not consider channel delays.

Figure 7-20. Add Waveforms of Computed and Ideal Electrical Angle
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Fixed Gain Control

The gain of the LDC5072 Spice model can be changed by adjusting the values of RAGC1 and RAGC2 in the 
test bench file LDC5072_TB.cir. In the circuit file, the two resistors form a potentiometer with one end connected 
to VREG, and the other connected to GND and the mid-point (wiper) is connected to the AGC_EN pin of the 
device model (in file LDC5072.cir). The lines from the test bench netlist are shown just below.

* Bias for AGC_EN pin:

• RAGC1 VREG AGC_EN 7.0E3
• RAGC2 AGC_EN VGND 93.0E3

* Instantiate the sensor and LDC5072:

• XSENSOR LCIN LCOUT IN0P IN0N IN1P IN1N ANGLE VGND SensorModel
• XLDC5072 LCIN LCOUT IN0P IN0N IN1P IN1N OUT0P OUT0N OUT1P OUT1N VDD VREG VGND 

AGC_EN TM0 TOUT LDC5072
• + PARAMS: LPFI = 0.000 LPFQ = 0.000 DLYI = 0.190 DLYQ = 0.190 COUTLOAD = {CLOAD} ILIM = 3.000 

m
• + IOFFSET = 0.000 QOFFSET = 0.000 IIMBAL = 0.000 QIMBAL = 0.000 INL = 0.01000

The values of RAGC1 and RAGC2 can be calculated via equation (7) in the device data sheet.

Gain  =  0.375  +  0.759 x  10 1.903x %VREG −  4.55 /90.9 −  1 (1)

Where:

• Gain is the effective gain set by the gain block.
• %VREG is the voltage on the AGC_EN pin expressed as a percentage of the voltage on the VREG pin:%VREG  =  100 x RAGC2/ RAGC1  +  RAGC2 (2)

.
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8 Layout, Bill-of-Materials, and Schematic of the Test PC board
As mentioned previously, the tool creates Gerber files of the sensor, target, and an evaluation PC board layout 
with a *.pdf file representation of the design. The images below show examples of PC boards created from the 
tool's default settings.
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Figure 8-1. Top Side of Sensor, LDC5072 and Target PC boards created by the LDC5072 Sensor Design 
Tool
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Figure 8-2. Underside of Sensor, LDC5072 and Target PC boards created by the LDC5072 Sensor Design 
Tool
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The schematic of the evaluation PC board created by the design is shown in the figure just below, and the parts 
list is shown in Table 8-1. Part placement on the PC board is shown in Figure 8-4.

Figure 8-3. Evaluation PC Board Schematic Without Sensor

www.ti.com Layout, Bill-of-Materials, and Schematic of the Test PC board

SNOU195 – JULY 2023
Submit Document Feedback

LDC5072-Q1 Sensor Design Tool Getting Started Guide 49

Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/lit/pdf/SNOU195
https://www.ti.com/feedbackform/techdocfeedback?litnum=SNOU195&partnum=LDC5072,


Table 8-1. LDC5072Q1EVM BOM
Designator Quantity Value Description Package PartNumber Manufacturer

C1 1 0.01uF CAP, CERM, 0.01 uF, 25 V, +/- 
10%, X7R, 0603 0603 GRM188R71E103KA01

D MuRata

C2 1 0.1uF CAP, CERM, 0.1 uF, 25 V, +/- 
10%, X7R, 0603 0603 C1608X7R1E104K080A

A TDK

C3 1 1uF
CAP, CERM, 1 uF, 35 V, +/- 
10%, X7R, AEC-Q200 Grade 1, 
0603

0603 CGA3E1X7R1V105K08
0AC TDK

C4, C5, C6, C9 4 6800 pF CAP, CERM, 6800 pF, 25 V, +/- 
10%, X7R, 0603 0603 GRM188R71E682KA01

D MuRata

H9, H10, H11, 
H12 4 Bumpon, Hemisphere, 0.44 X 

0.20, Clear
Transparent 
Bumpon SJ-5303 (CLEAR) 3 M

J1 1 Standard Banana Jack, 
insulated, 10 A, red 571-0500 571-0500 DEM Manufacturing

J2 1 Standard Banana Jack, 
insulated, 10 A, black 571-0100 571-0100 DEM Manufacturing

J4 1 FFC/FPC Connector, 6 POS, 
0.5mm, R/A, Tin, SMT

FFC/FPC 
Connector, 6 
POS, 0.5mm, 
R/A, SMT

52745-0633 Molex

J8, J9 2 Header, 2.54mm, 2x1, Tin, TH
Header, 
2.54mm, 2x1, 
TH

22284023 Molex

LBL1 1
Thermal Transfer Printable 
Labels, 0.650" W x 0.200" H - 
10,000 per roll

PCB Label 
0.650 x 0.200 
inch

THT-14-423-10 Brady

R1, R2, R3, 
R4, R10 5 0 RES, 0, 5%, 0.1 W, AEC-Q200 

Grade 0, 0603 0603 CRCW06030000Z0EA Vishay-Dale

R5 1 49.9k RES, 49.9 k, 1%, 0.1 W, AEC-
Q200 Grade 0, 0603 0603 ERJ-3EKF4992V Panasonic

R7, R11, R12, 
R13, R14, R15 6 0 RES, 0, 5%, 0.125 W, AEC-

Q200 Grade 0, 0805 0805 CRCW08050000Z0EA Vishay-Dale

R9 1 50k Trimming Potentiometer, 50K, 
0.5W, TH 9.53x8.89mm 3352T-1-503LF Bourns

R16, R17, R18, 
R19 4 10.0k RES, 10.0 k, 1%, 0.1 W, AEC-

Q200 Grade 0, 0603 0603 CRCW060310K0FKEA Vishay-Dale

SH-J1 1 Shunt, 2.54mm, Gold, Black Shunt, 
2.54mm, Black 60900213421 Wurth Elektronik

TP1, TP2, TP3 3 Test Point, Compact, Blue, TH Blue Compact 
Testpoint 5122 Keystone

TP4, TP5, TP6 3 Test Point, Compact, Black, TH Black Compact 
Testpoint 5006 Keystone

U1 1
Inductive Position Sensor with 
Sin/Cos Interface, PW0016A 
(TSSOP-16)

PW0016A LDC5072PWQ1 Texas Instruments

C7, C8, C13, 
C14, C15, C16, 
C19, C20, C21, 
C22, C25, C26

0 18 pF CAP, CERM, 18 pF, 100 V, +/- 
5%, C0G/NP0, 0603 0603 GRM1885C2A180JA01

D MuRata

C10, C17, C23 0 330 pF CAP, CERM, 330 pF, 50 V, +/- 
5%, C0G/NP0, 0805 0805 08055A331JAT2A AVX

C11, C18, C24 0 330 pF CAP, CERM, 330 pF, 50 V, +/- 
1%, C0G/NP0, 0603 0603 C1608C0G1H331F080

AA TDK

C12 0 0.1uF CAP, CERM, 0.1 uF, 25 V, +/- 
10%, X7R, 0603 0603 C1608X7R1E104K080A

A TDK

FID1, FID2, 
FID3 0 Fiducial mark. There is nothing 

to buy or mount. N/A N/A N/A
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Table 8-1. LDC5072Q1EVM BOM (continued)
Designator Quantity Value Description Package PartNumber Manufacturer

J3 0 Terminal Block, 4x1, 2.54 mm, 
Green, TH

Terminal Block, 
4x1, 2.54 mm, 
TH

1725672 Phoenix Contact

J5, J6, J7 0 Header, 100mil, 2x1, Gold, TH 2x1 Header TSW-102-07-G-S Samtec

R6 0 10k RES, 10 k, 5%, 0.1 W, 0603 0603 RC0603JR-0710KL Yageo

R8 0 1.0k RES, 1.0 k, 5%, 0.1 W, AEC-
Q200 Grade 0, 0603 0603 CRCW06031K00JNEA Vishay-Dale

Figure 8-4. Detailed EVM Relative Part Placement for Soldered Components - Identical to Tool-Generated 
EVM
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9 Troubleshooting
If the tool does not seem to be creating a design based on GUI input, then the tool state file located at folder 
application/L12_CB.mat is possibly corrupted. Try deleting this file and start again.

Figure 9-1. LDC5072 Sensor Designer State File

The time to complete the design process varies with size and complexity of the sensor – typical times are two to 
eight minutes. If the design time is longer than 30 minutes, then the optimizer is probably stuck or the meshing 
cannot satisfy the error tolerances. Close the tool and start again with a different set of parameters. Table 9-1 
shows some examples of elapsed times to generate a design for different conditions. Note these times can vary 
depending on the user's hardware and operating system.

Table 9-1. Approxmate Sensor Tool Elapsed Times for a Given Set of Design Parameters
Design Diameter (mm) E/M Layers Turns/Layer Design Time 

(min:sec)
1 75 3 1 6 2:04

2 102 2 4 1 15:03

3 51 3 2 4 6:08

4 32 4 5 2 5:29

5 35.7 5 3 3 3:18

6 64.2 1 6 1 1:20

7 35 4 3 3 1:36

If the Gerber files show strange routing or shorts, then the trace width, spacing, or VIA dimensions are 
insufficient for the sensor size or electrical-to-mechanical ratio.
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If you are having difficulty with the tool please feel free to post an inquiry on the Texas Instruments Sensing E2E 
Forum. As part of the inquiry, please attach the following to your E2E thread:

1. The *.sns design file created by clicking the “Save Design" button on the front panel of the tool (see first 
figure below).

2. A text file containing a copy of the text in the tool’s “log” window (second figure below).
3. The “LDC5072_Sensor_Designer.log” data file in the application directory of the install folder.

10 Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

DATE REVISION NOTES
July 2023 * Initial Release
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